Unit 1: Working With Tables
Unit Overview

• This unit covers the basics of working with Tables and the Table wizard.

⚠️ It does not include working with fields, which is covered in Units 3 and 4.

• It is divided into the following sections:
  • Tables Overview
  • Working with Layouts
  • Action Bars
  • Permissions and Ownership
  • Indexes
Questions Covered

• What terms do we use for the basic components of Agiloft?
• How do we create new tables?
• How do we create and modify the form layout for records in a table?
• How do we customize the options available on action bars?
• How is the ownership set for records in a table?
• Should we add fields to the indexing for this table?
Prerequisites

• Review the Admin Overview Video – this video defines the basic concepts and vocabulary you will need to understand what follows. It also provides an overview of the admin setup menus.

• Have your login information ready for your Training KB for the hands-on portion of this unit.
Table Terminology Defined

- **Knowledgebase (KB)** is the entire collection of interrelated tables, users, and automation that make up a single Agiloft instance.

- **Tables** are top-level database containers within a given KB; each table contains a set of fields (columns) that define what data is stored in the table. Tables contain any number of records which share the same basic characteristics.
  - Example: The Vendor table contains a record for each vendor; the People table contains a record for each person or contact.

- **Records** are individual items within a table; each record is made up of many fields, which hold the different attributes of that record.
  - Example: Within the Vendor table, there may be a record for Agiloft, IBM, and Hewlett Packard.

- **Fields** store individual pieces of information which make up the record.
  - Example: The Vendor record may have fields for Address, City, State, Zip, Main Contact, Main Phone Number, and Vendor Type.
Tables Overview
Example of a Table View

- Within a **table view**, each record is organized as a row and runs horizontally; fields are shown as columns and run vertically.
- We will discuss the **action bar** and **search box** a little later on.
From an implementation perspective, it is helpful to think of two main categories of tables.

- **Background tables** hold relatively static data used in the other tables. Background tables do not generally have business processes or significant automation associated with them.
  - Example: Vendors, People, Locations, and Assets.

- **Process tables** hold records that are actively worked on, usually with some kind of workflow and dynamic activity. They generally pull in records and field values from the background tables, such as the vendor for a contract.
  - Example: Contracts, Tasks, Support Cases, and Change Requests.

All implementations include both types of tables. Usually, background tables are built before process tables.
The Table Tree lists all of the tables in the system. It is accessed through the **Setup > Tables** menu on the left pane. The following actions can be performed from here:

- **New**: Create a new table.
- **Edit**: Make changes to an existing table.
- **Move**: Move a table up or down within its hierarchy.
- **Deactivate**: This removes the selected table from the left pane for all groups. It will still appear in the Table Tree, and may still be accessed from within other tables.
- **Activate**: This adds the selected table back to the left pane for the admin group only. The table must be re-activated for other groups by editing their group permissions to show the table.
Tables and Subtables

- Subtables may be created under any table and are shown in the Table Tree with a plus/minus sign:

- For example, Employees and External Users are subtables under the People table.

- Subtables can have independent layouts, additional fields, and distinct permissions.
  - For instance, users can be allowed to create External Users but not Employees.

💡 Internally, a subtable is not really a separate table from its parent.

⚠️ **Subtables complicate an implementation and should be used sparingly!**
How Do We Create a New Table?

- Setup > Tables > [Select the Table Tree] > New
Default Fields for New Tables

- When a new table is created from the **table tree**, it inherits the following fields:

<table>
<thead>
<tr>
<th>Field label</th>
<th>Field name</th>
<th>Field DbName</th>
<th>Data Type</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created By</td>
<td>_1880_full_name</td>
<td>_1880_full_name</td>
<td>Link to selected fields from other table</td>
<td>Contactfull_name/Full Name</td>
<td></td>
</tr>
<tr>
<td>Creator Login</td>
<td>creator_login</td>
<td>creator_login</td>
<td></td>
<td>_login/Login</td>
<td></td>
</tr>
<tr>
<td>Creator Team</td>
<td>creator_team</td>
<td>creator_team</td>
<td></td>
<td>_100_sw_description/Primary Team</td>
<td></td>
</tr>
<tr>
<td>Date Created</td>
<td>date_created</td>
<td>date_created</td>
<td>Date/Time</td>
<td>$Creation_date</td>
<td></td>
</tr>
<tr>
<td>Date Updated</td>
<td>date_updated</td>
<td>date_updated</td>
<td>Date/Time</td>
<td>$Modification_date</td>
<td></td>
</tr>
<tr>
<td>Deletable</td>
<td>deleteable</td>
<td>deleteable</td>
<td>Choice</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Demo Data</td>
<td>demo_data</td>
<td>demo_data</td>
<td>Choice</td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>History</td>
<td>history</td>
<td>history</td>
<td>History</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td>id</td>
<td>id</td>
<td>Auto-Increment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>type</td>
<td>type</td>
<td>Type of the SW object</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Updated By</td>
<td>_1888_full_name</td>
<td>_1888_full_name</td>
<td>Link to selected fields from other table</td>
<td>Contactfull_name/Full Name</td>
<td></td>
</tr>
<tr>
<td>Updater Login</td>
<td>updater_login</td>
<td>updater_login</td>
<td></td>
<td>_login/Login</td>
<td></td>
</tr>
<tr>
<td>Updater Team</td>
<td>updater_team</td>
<td>updater_team</td>
<td></td>
<td>_100_sw_description/Primary Team</td>
<td></td>
</tr>
</tbody>
</table>
Changing the Default Fields

• You can change the default fields at the top level of the table tree so new tables will inherit different/additional fields.
  • Example: You might want to delete the Demo Data field, which is used to keep demo data up to date.

• Adding a new field at the top level of the table tree will immediately add that field in all existing tables.
  ◼️ This can take quite a while in a live system.

• Other changes at the top level of the table tree do not affect tables that already exist, just new tables.
Other New Table Infrastructure

- When a new table is created:
  - A *communication search result* field is added in that table to display emails sent to or from records in the table.
  - Access to the table is given only to the admin group.
  - The table is added throughout the system wherever a table tree hierarchy is shown for selection.
- When a *subtable* is created by first selecting another table then clicking *New*:
  - All fields, layouts, permissions, views, and searches are inherited from the parent table.
How Do We Build Out a New Table?

• Building and editing tables is done through the Table wizard. The wizard makes it easy to define fields, create form layouts that are displayed to users, and configure rules, actions, dependencies, set ownership, and so on.

• Access the Table wizard by creating a new table or by editing an existing one.
Overview of the Table Wizard Tabs

- **General**: Name the table and set whether or not the table is deletable.
- **Graphics**: Choose an icon to represent the table.
- **Fields**: Create and edit fields.
- **Layout**: Arrange the fields on the form that users will access.
- **Action Bar**: Create and edit action bars.
- **Action**: Create and edit actions.
- **Workflow**: Set the workflow states and transitions for the table.
- **Rules**: Create and edit rules to automate business processes.
- **Permissions**: Set record ownership and general access to the table.
- **Indexes**: Configure various indexing options to optimize searching.
- **Conversion**: Set up field mapping to auto-create new records in other tables from fields in the current record in the current table.
- **History**: View the audit trail of all changes made to the current table.
- **API**: Generate sample Web Services code for use in integrating with backend systems.

*Tabs covered in this unit.*
Let’s Create a Table

• In the left pane, click Setup.

• Select the Tables menu option. This opens the table tree.

• Make sure the top item in the table tree is selected and click New.

• On the General tab, set your Table Label to “Task”. Press the Tab key and see how the Plural Table Label and Table Name auto-populate.

⚠️ The system creates the Plural Table Label by adding an “s” to the end of the Table Label. If the plural form of your Table Label is non-standard, be sure to edit this field manually.

• Click on the Graphics tab to proceed.
Add a Graphic and Save the Table

• This tab is used to select an icon representing the table in the left pane.
  ⚠ You can upload your own icons—the default icons are 20 x 20 pixels. Making all icons the same size will provide smooth scrolling in the left pane.

• Select an icon from the list of unused icons.

• For consistency, select Default unselected icon for the Icon When Table is Unselected option.

• Click Finish to save your table. You will be returned to the table tree.

• Confirm that your Task table has been created. We will be using this table in later exercises.
An Important Note – Do Some Reading!

• Did you notice the text to the left of the Table wizard?

• When working in any Agiloft wizard, the left side of the screen has a description of each option, as well as tips and guidance and links to additional information.

• Read through these notes until you feel comfortable with each option.

• If you still have questions, you can always search through the Help menu at the top right.
Table Overview Summary

- We have learned:
  - How tables are created and what fields they inherit by default.
  - The difference between a table and a subtable.
  - How to create a table and choose a graphic for the table.
  - How to use the text on the left of the Table wizard (and all other wizards) to help guide you through the creation process.
Working With Layouts
Questions Covered

• How do we adjust the arrangement and order of the fields users see when filling out a form?
• Can we create a separate form for staff users and end users?
• How do we change the fields included on a form?
What is a Layout?

- **Layout** refers to the arrangement of tabs, fields, and heading text within a record form.
- The **Layout** tab is where we create the record form layout.
- There are two layouts per table: the **Staff** layout and the **End User** layout.
  - The layout used depends on which interface the user logs into. Staff (power) users require a staff license and generally log in to the staff interface.
  - The layout is manipulated via a drag-and-drop editor.
Working with Layouts

Place cursor within the Layout, then insert a column heading, column, row, or tab using these buttons.

You can drag and drop fields within a tab or onto another tab.

You can choose different alignment rules and whether or not input boxes are expanded to align.

Select and delete any columns, rows, tabs, or text headings here.

Drag fields you don’t want to see onto the Hidden tab.
Navigating the Layout Tab

• In the left pane, click on Setup Contracts. If that option is not visible, click the down arrow to the left of Contracts.
• Navigate to the Layout tab in the Contracts table wizard.
• The Common Area is the first tab shown. Note the fields in this area and then click on the Contract Details tab to see the fields on that tab.
• Proceed to navigate through each tab, noting the types of fields contained within each.
• When you reach the Hidden tab, click Preview to see what the layout looks like for a new record.
The Common Area

- Fields in the common area are always displayed above the fields on the other tabs. Because common area fields are visible no matter which tab a user navigates to, they should be the most relevant fields that provide critical information about the record, such as ID, Status, and the record’s name, title, or summary field:
More on the Common Area

• The Look & Feel scheme allows you to define a different background color and style for the common area as well as the separator used below it. We will cover Look & Feel schemes in more detail in a later unit.

💡 We recommend not putting more than 3 or 4 rows in the common area as it reduces the room for fields on the other tabs.

💡 A text heading at the top of each tab helps to visually separate the fields on that tab from the common area.

• The common area columns are aligned with the fields on the first tab.
Layouts and Permissions

- The layout provides the superset of the fields that a user may view/edit for a record.

- Users will only have access to view fields on the layout if they have view permission to that field. We will cover permissions in a later unit.

⚠️ Taking a field off of the layout does not by itself prevent access to that field. The user can still show the field in a table view or search for content on that field if they have permission to view the field.

- A field on the layout may also be hidden from a user if the field is visibility dependent on another field having a certain value, and that condition is not met.

💡 When designing the layout, it is best to keep the visibility dependent fields and those that some users do not see to the right or on their own lines, as fields remain in their column positions whether or not any fields to the left are visible.
Layout Considerations

- The goal of a layout is to be efficient to navigate and visually appealing.
- Generally a two-column display is easiest to use, except where there are very short fields that can be shown in three columns.
- Ideally, the first tab will have all required fields.
- **Related tables** will load in the background if they are not on the first tab.
  ☢ Avoid putting related tables on the first tab in order to increase the speed of loading the form.
- Text headings help organize the form and we recommend using them liberally.
- A tab will only be seen by users who have permission to view or edit fields on that tab.
- A tab will *not* be hidden from users if the fields on it are visibility dependent on another field value, it will just appear empty.
Some Additional Tips

- **Linked fields** can skew the alignment because space is reserved for the field before it is populated, pushing other fields to the right.
  - This can be fixed by editing the linked field and changing its displayed field length to a shorter value.

- Alignment selections are critical and have a major impact on the layout.
  - Aligning all columns gives the cleanest display when there are only two or three columns.
  - It is usually preferable to turn off the **Expand input boxes** option, as it makes narrow fields look a bit strange.
  - Increasing the **Width of multi-column fields** can sometimes greatly improve a layout’s alignment and appearance.
Let’s Edit a Layout

• The next few slides will take you through editing various features of a layout. All exercises will be done in the Contract table.

• You will be editing the Staff layout in this exercise.
Editing a Layout: Field Placement

- In the Contracts table wizard, navigate to the Layout tab. The common area has several action buttons that are visibility dependent based on the Status. Usually a common area has fewer rows.

- In the common area, locate the Progress Bar Image field. Drag and drop it to the Hidden tab. This is where we store fields we don’t want to see.

- Locate the Status field. Drag it up to the Contract Details tab and drop. Navigate to the Contract Details tab and confirm the Status field is there.

- Locate the Requester Department field from the list of available fields (these fields are listed alphabetically). Drag it onto the Contract Details tab, then click on that tab and drag the field next to Requester Email.

- Make any other changes you like.

- Click the Preview button to see the results of your changes.
In the Contract Details layout tab, select the Company Main Contact field.

In the New options section, click the Text button. Replace “&nbsp” with “Party Contact Information” and click Finish.

Suppose you don’t want to use approvals. Select the Notes and Approvals tab. In the New section, click Rename Tab. In the pop-up, rename the tab “Notes” and click Finish.

Drag and drop the Approvals Received and Approvals Needed fields onto the Hidden tab, and then select each related text heading and in the top section next to Delete click Text to remove them.

Insert a row somewhere by clicking on a field in a row and navigating up to the New section and clicking Row. Then drag a field onto it.

Click the Preview button to see the result of your changes.
Editing a Layout: Alignment Options

• Select the **Set Alignment** button. This opens a new window with various options.
  
  • Select each of the alignment options under the **Choose how to align columns** heading, then click **Preview** each time to see the result of your changes.
  
  • Open the **Alignment Options** window again. Under the third set of options, check the box to **Expand input boxes that are left aligned to right align them**. Click **Finish** and preview to see the result of your change. You will notice input fields looking stretched on the layout.
  
  • In the **Alignment Options** window, change the width of multi-column fields to 35 characters. Click **Finish**. Click the **Preview** button to see the result of your change.
The End User Layout

- The **Staff** layout can be copied to create an **End User** layout:

![End user and Staff buttons]

- It is usually most efficient to **Copy this layout to the End User Layout**, then click the **End User** button to go modify the End User layout and remove fields.

💡 Use the **Hidden** tab to hold any fields you don’t want users to see. It has the same effect as leaving the field in the **Available Fields** section of the layout editor.
Layout Summary

• We have learned how to:
  • Edit an existing layout.
  • Rearrange where and how fields are displayed.
  • Change the alignment settings.
  • Create an End User layout.

• To expand your understanding:
  • Experiment with other layouts.
    ▪ Do not be afraid to try deleting rows, columns, or text bars.
    ▪ Be sure to try out various alignment options.
    ▪ Make note of how each change affects the record display.
  🌟 Remember, your goal is an efficient and visually appealing layout.
Action Bars
Questions Covered

• What is the action bar?
• How do we change what menu options users see above a table when looking at a table view?
• Can different sets of users see the options arranged differently?
• How do we add our own custom actions to the action bar?
• Can custom actions run on multiple records?
• How do we show different options on the action bar when displaying a table within another record versus displaying the same table from the left pane menu?
  • Example: When displaying contacts within a Contract record, restrict users from creating new contacts; allow them to create new contacts from the main table view.
What is the Action Bar?

- The **action bar** appears above the **table view** and shows buttons and icons for actions that can be applied to one or more records.
- Every table is created with a default action bar similar to the one shown above. The default is automatically applied to every team that does not have a custom action bar assigned to it.
- A user’s primary team determines which action bar they see.
- Administrators may add custom **action buttons** to the action bar that can run custom actions on multiple selected records.
Action Bar and Permissions

- The menu items displayed on the action bar are further controlled by group permissions.

- For any action bar, users can only see the actions their groups have permission to use.
  - For example, if none of the user’s groups is allowed to create records in this table, they will not see the New button; if they are not allowed to print records, they will not see the Printer icon.
Why Have More Than One Action Bar?

- Multiple **action bars** with different actions can be configured for a particular table and assigned as the defaults for specific teams.

💡 Example: You might show different actions to people who are in the same permission group, but belong to different teams with different responsibilities.

- When showing a table within a record in another table, you may not want people to be able to perform the same actions as when they use that table from the left pane.

  - Example: When users view contracts in a **table view** from within a record in another table, you may want them to use a custom action button rather than the **New** button on the **action bar**. This way you can map field values into the contract from the current record. To prevent users from using the **New** button, you can define a separate action bar with no **New** button and apply it to the table where you are viewing contracts.
• The Action Bar wizard is accessed from the Action Bar tab of the Table wizard when creating a new action bar or editing an existing one.

• The wizard is made up of the following tabs:
  • **General**: Name the action bar and provide a description.
  • **Design**: Select the actions to make available.
  • **Apply**: Specify which teams will use this action bar as their default.
Let’s Edit an Action Bar

- In the left pane, click the arrow next to Contracts to expand the menu, then select Setup Contracts.
- Click the Action Bar tab, and edit the Training Action Bar. Navigate to the Design tab.
- In the right column, select the Mass Edit action. Click the Remove button to remove it from the action bar.
- Remove the Delete and Add Note actions similarly.
- Expand the Actions folder by clicking the “+” next to it. Locate the Copy action. Drag and drop it right below the New action.
- Add a Separator and drag it up below the Copy action.
- Add Search to the action bar.

⚠️ If you decide to make additional changes, do not remove Search. If this action is not available we will not be able to search for records in the Contracts table, which will make Unit 5, Searching in Agiloft, much more difficult.
Let’s Add a Custom Button to the Action Bar

- To add a custom *action button* to the *action bar*, choose *Action Button Item* in the *Type of Action* drop-down.
- This will show a list of the action buttons defined for this table.
- Select the *Mark as Signed* button and click *Add* to add it to the action bar.
Editing an Action Bar: Apply Tab

- Navigate to the Apply tab.
- Choose the option to Change Settings. Check the box next to Action Bar is the default for teams. This will activate the list of teams for selection.
- Click Select All to make this the default action bar for all teams.
- Check the appropriate boxes to make this the default action bar for any sub-teams and any new teams that are created.
- Click Finish to save your changes.
- Click on the Contracts table in the left pane to view the results of your changes.
- Select a contract whose Status is not Active, and click Mark as Signed on the action bar to see the result. The Status should change to Active (if the start date is prior to today) or Signed (if the start date is after today).
Let’s See a Related Table Action Bar

- Let’s examine the action bar being used in the Contracts table to display Amendment Contracts, without allowing users to create them.

- Click on Setup Contracts in the left pane, and navigate to the Action Bar tab. Edit the action bar called Related Table no New Option.

- Navigate to the Design tab. These are the minimum options generally included on an action bar for a related table: Click to search records, Unlink, and Print Records.

⚠️ **Click to Search Records** allows users to find and create a link to records in the related table, and Unlink unlinks records from within the related table.

⚠️ The Search icon is used for running ad hoc or saved searches to further filter records in the related table. It uses the same icon as Click to Search Records by default, but this can be changed on the Icons tab of the Look and Field wizard.

- Now click on the Contracts table in the left pane, edit Contract #143, and go to the Related Contract / Renewals tab to see what this looks like – it is used for the Related Amendments table. The Create Related Contract button above is used to create a new Amendment contract instead of a New button on the action bar.
More Practice with Action Bars

- Based on what you know, create a new action bar and apply it to a table.
  - Instead of clicking the Edit Icon, select New from the action bar above the action bars table.
- Try adding one or more action buttons to the action bar.
- Try creating new menu items and regrouping the standard items.
Action Bar Summary

- We have learned how to:
  - Edit an existing action bar.
  - Create a new action bar.
  - Use different action bar configurations in different scenarios.

- To expand your understanding:
  - Experiment with the other action bar options and combinations.
    - Different options and combinations will work better on some tables than others.
    - Example: You may want to print records on a Vendor or Customer table, but not on the Project Types table.
Permissions and Ownership
Questions Covered

• What is record ownership?
• Who owns a record and how is this configured?
• How can we control who is able to view and edit different records within the table?
• Where is the best place to set permissions for a table?
Table Permissions – What is Record Ownership?

• In the Agiloft system, each record has a defined “owner.”
  • Example: An employee may “own” their own Employee record.

💡 **Ownership** is used to control record access. Users accessing the system under the End User license may only edit records they “own.” They may view other records.
  • Example: End User employees may be able to edit only the Employee records they own. Jane Doe can edit her own employee record, but not John Doe’s.

• Records are usually owned by a single user. For example, in the Task table a record is owned by the person whose own Full Name field matches the Assigned Person field.
Table Permissions—Which Records are “My Own”

- Click **Setup Contracts > Permissions** and check to make sure the field selected under **Field used to define ownership** and the field selected under **Matching field in People table** are the same kind of field (an ID, in this case) and will match. This section defines who owns the record, so if the fields used are not in sync then the system won’t know how to grant access.
Record Ownership Considerations

- A Power User (Staff) license potentially allows users to edit any record.
- An End User license limits a person to edit only records they “own” (they can create and view any records they are allowed).
- For most tables, it is preferable to use individual ownership to define who should be able to edit a record.

💡 The field should ideally be a unique field, rather than the person’s name – either Login or ID.
Edit Table Permissions: Record Ownership

• Go to Setup Tasks to edit your new Tasks table. Navigate to the Permissions tab.

• In the Field used to define ownership, select the Creator Login field.

• In the Matching field in Contacts table, select Login.

• Note that the two fields must contain the same value to grant record ownership.
  
  • Example: Created By stores a user’s full name, e.g. Sam Spade. Login stores a user’s login for the system, e.g. sspade. If ownership is set to match the Created By field to the Login field, Sam Spade will not own the record in question since Sam Spade ≠ sspade.
Edit General Table Permissions

- The other permissions options in the Table wizard allow you to set very general access to the table.

⚠️ All refined record level permissions are best set in the Group Permission wizard which we will cover in a later unit.

- For your new Tasks table, set the basic record level permissions as follows:
  - Multi-select the Admin, Professional Services, Support Manager, and Support Staff groups to be able to create, view own, view others, edit own, and edit others’ Tasks.
  - Allow only the Admin group to delete own and other’s tasks and perform the rest of the functions.
  - Click Finish to save your changes.
Permissions Summary

• We have learned how to:
  • Set Record ownership.
  • Edit General Table Permissions.
Indexing
Questions Covered

• What is the **Indexes** tab used for?
• Do I need to create custom indexes for tables?
• Should I create as many indexed fields as possible?
What is the Indexes Tab Used For?

- The system automatically performs a full text index of all data in the system on all tables, including in attached files.
- The *Indexes* tab allows administrators to create additional indexes for specific fields that are used very frequently in searching to speed up those searches.
  
 💡 It is not usually necessary to add a custom index.
- *Full Text Indexing* can be turned off for tables with a lot of records that do not need to have instantaneous searches of their content.
- From the *Indexes* tab, you can change the fields that appear in the drop-down of the table search block.
Adding an Indexed Field

• Let’s add an indexed field to the Contracts table.
• Click on Setup Contracts in the left pane and navigate to the Indexes tab.
  • Note that there are already some indexed fields.
• Since we have several saved searches using the Status field, let’s add that field. Click New and select the Status field.
• Click Finish to save the indexed field.
  • You might notice that after being saved the newly indexed field appears as Workflow State, not Status. This is a brief anomaly and the field name will change back to Status.

⚠️ When you save a new indexed field, the system will proceed to index the existing records, which may take some time.

💡 You can combine multiple fields in one index to index particular combinations for searching. This is usually not needed.
Editing the Quick Search Fields

- From the Indexes tab on the Contracts table, locate and select the Edit Quick Search Fields button on the bottom of the screen.
- By default, all the fields are selected. Select Clear All Fields and click Finish.
- Navigate to the Contracts table in the left pane and select the search drop-down.
- Notice that the only search option left in the drop-down is -TEXT-.
- Now go back to the Indexes tab and select Edit Quick Search Fields. You can either select all fields or choose a few fields that you want users to access from the drop-down.
- Click Finish and navigate back to the Contracts table to see the results.
Indexing Summary

- We have learned how to:
  - Add one or more fields to the full text indexing.
  - Turn off indexing for a table.
  - Add Quick Search fields to the table search block drop-down.
Conclusion

This concludes the unit on working with tables!